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Installation
Unpack the archive you have downloaded and copy/paste the file "Limber.jsxbin" to
your “ScriptUI Panels” folder, located here:
Windows: Program Files\Adobe\Adobe After Effects <version>\- Support Files\Scripts
Mac OS: Applications/Adobe After Effects <version>/Scripts
If the ScriptUI Panels folder does not exist, create a folder and name it “ScriptUI Panels”.
2. Go to the General tab of After Effects’ Preferences pane and make sure that ‘Allow
Scripts to access the network’ is checked ON
Once installation is finished run the script in After Effects by clicking Window > Limber

How Limber Works
Limber uses shape layers to make limbs for character
animation. It can be faster and more powerful to use than
other scripts because of it’s unique features and range of
customizing options. Limber can generate two types of
limb: tapered and bones. Tapered limbs are based on
three circles connected with a continuous outline around
them. Bones are made of a single path; they’re designed
to be really fast to preview and render. Bones require
After Effects CC2018 or newer.
Limber generates three layers for each new limb, which we call a set of layers: The limb
layer itself, and two controllers that correspond to the position of the start (shoulder or
hip) of the limb, and the end (wrist or ankle). The controllers are guide layers so that
they don't appear in your final render. Usually, you’d parent the start controller to your
character's body layer, and keyframe the end controller's Position property to animate.
There is a ‘Limber’ effect on the end controller that gives you several properties to
determine the appearance and behavior of the limb. If you make a new limb and adjust
these properties, you’re using what we call a basic limb. For users who are comfortable
modifying shape layers, the limb layer itself can be altered or added to, and we call
these custom limbs, because they are not permanently stored by the script. Limber can
copy and paste these custom limbs, but you need to keep a version of them in a comp
somewhere if you want to be able to re-use them in the future. The Limb Library After
Effects project file included in the Limber download contains a selection of custom
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limbs that we’ve designed for you, some of which add functionality the basic limbs
don’t have, such as muscle bulges on the tapered limbs or bendy joints on bones.

New Limbs
Firstly, select either Arm, Leg or another preset from the lefthand dropdown menu.
Then select the Type in the other dropdown to choose between types of limb:
2017 and earlier - the tapered limb for use in versions of After Effects prior to CC2018
2018 and later - the tapered limb for use in After Effects CC2018 and later.
Bone - bones only work in CC2018 and later.
Then click New and you'll get a popup asking you to name the limb. This is so you can
differentiate between several limbs within a character, such as left and right, as well as
between different characters if there are several in your comp. The layer names can
always be altered later if you change your mind but it's a bit quicker at this stage.
Limber will make a new set of layers and
give each one an appropriate name. For
example, if you selected ‘Leg’ and
specified ‘redguy-R’ you’ll get ‘redguy-RAnkle, ‘redguy-R-Hip’ and ‘redguy-R-Leg’.

If you change a Limber layer's name, the
expressions automatically update, taking
advantage of AE’s native expression layertracking, and they’ll still refer to the same
layers. Unfortunately, this means you cannot
use third-party layer naming utilities to update
your Limber layer names.

Layer name presets
To change the suffixes that Limber applies to your
layer names, click on the gear icon button next to the
first dropdown. Select a preset and you can remove it
using the - button, add a new one with the + button,
change the display order by clicking the up or down
buttons, or edit a preset in the textfields on the right.
Presets are saved locally when you hit OK.

Limb properties
To change the look and behavior of a basic limb, select the end controller and twirl
down the Limber effect's property groups:

Shape

The lengths of the limb determine how long it is, in pixels. From the center point of the
hip to the center point of the knee is Upper Length and similarly, from the knee to the
ankle is the Lower Length. The Start Size, Middle Size and End Size determine the
diameter of the three circles, in pixels. The Square End property makes the end circle
invisible, so you have the appearance of a boxy, square end to the limb.
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Scale

The Size Scale property will scale all the three circle sizes at once. If you have Link
Length to Size Scale checked, the length of the limb will scale up proportionally, too.
This enables you to scale a limb along with the rest of a character - see the 'Scaling'
section below.

Colors

The Upper Split and Lower Split properties determine where the upper and lower parts
of the limb are split, by a straight line, into different colors. The upper part uses the
Upper Color and Middle Color, while the lower part uses the Middle Color and the
Lower Color. The splits are a percentage of the length of each part, calculated from the
most distant edges of the two circles rather than their centers.

Bones don’t respond to Size options because they are stroke based and so cannot
taper. They also don’t respond to Square End or Color choices because doing so slows
them down a bit (check out the Colored Bone in the Limb Library if you want that). We
wanted to keep Bones as fast and simple as possible. If you want to style a Bone, you
can change the Stroke Color and Width on the limb layer to whatever you like, inside
the limb layer.

Dynamics
The Clockwise property will determine whether the joint bends out to the left or to the
right. Usually you’d set this to either 100% or -100% and then leave it, but it can be
keyframed between these values for certain inbetweens. At 0% the limb will always
appear perfectly straight regardless of where the controllers are, as if the
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joint was pointing directly towards or away from the viewer rather than out to one side.
When you copy and paste styles from one limb to another, the Clockwise property
values are not pasted (because you often want to paste a left-facing limb’s style onto a
right-facing one.)
The Rotate Start and Rotate End properties will enable the respective controllers to
automatically rotate along with the limb, when they’re at 100%. At 0% the controllers
will not rotate as they move around. You can keyframe between auto-rotation and nonrotation to make transitions between poses or cycles of animation easier.
The Stretch property enables your limb to stretch beyond it's nominal length. If
unchecked, the limb will not extend to an end controller that is further away from a
position where the limb is dead straight. If you have a foot layer parented to the end
controller, and you want limited-length legs, you can use an FK controller to get a nonstretchy foot to ‘stick’ to the leg. See the Forward Kinematics section below.
Anti-pop helps prevent the visual pops or jerking that can occur in IK animation, such as
when limbs become straight too suddenly. It works by making the limb shorter around
90º, and the normal length when dead straight (and fully folded up). Values above 50%
tend to work best with Anti-pop.

Duplicating an existing Limb
To duplicate a limb, select one of it's layers and click the Duplicate button. This will
bring up a popup window that prompts you to change the first part of the layer name,
the idea being that if you had named the first limb set 'Right' you could now name the
duplicate limb ‘Left’. Custom limbs can be duplicated just like basic limbs, and the limb
layer will be an exact copy of the one being duplicated.

Copying and Pasting Limbs
Select a Limber layer, click Copy, then select a layer from a different limb set and click
Paste. The pasting process actually deletes the limb layer of the destination set and
replaces it with a full blown copy of the copied limb layer, updating the expressions so
as to link it to the destination limb’s controllers. The Limber effect properties (Lengths,
Sizes, Colors etc) on the end controller are also pasted (except Clockwise and those in
the FK Group). If you hold Alt whilst clicking Paste, the limb layer is pasted without
changing those properties. This is often what you want when copying and pasting
custom limb layers, if you’ve already set the basic size and color of your destination
limb.
When pasting, certain layer properties such as markers, masks, opacity, switches and
effects on the destination limb layer, may be lost, replaced or reset. Keyframed
properties are copied using the value at the current time. If your destination limb has
keyframes on Limber properties affected by the Paste operation, the script makes a new
keyframe for them at the current time.
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About Limb sets
Many of the operations in Limber require you to select one or more Limber layers. Most
of the time, it doesn't matter which of the three layers in a set you have selected. If I
want to duplicate a limb, I can select the limb layer or either of the controllers and hit
the Duplicate button. If you’ve selected more than one from the same set, the script
only performs the operation once. Likewise, you can select layers from more than one
limb set, and the operation will run sequentially. I could select all the layers in my
comp, click the Duplicate button, and the script would make duplicates of every limb.

Replacing a Limb Type
You can replace (previously called swapping) limb layers with fresh copies of basic
limbs, whilst retaining all the properties in the Limber effect. Typically, this might be
between a basic Tapered limb and a Bone, and then back to a basic limb, to temporarily
take advantage of the speed boost of the bone. Select one or more limb layers, choose
the type you want to replace them with in the Type dropdown in the UI, and click
Replace. The limb layer is then replaced by a fresh copy of the selected type, but the
controllers, including properties you’ve
altered in the Limber effect, are
If you want to temporarily switch from a custom
untouched. Those sizes and colors and so
limb to, say, a Bone; you would need to first
save your custom limb somewhere else (e.g in
on all reappear when you swap back to a
another comp) so that you could use Limber’s
tapered type. But any changes you have
Copy and Paste functions to paste that custom
made to the limb layer itself (meaning that
limb back. You can select all the layers in a limb
limb is now a custom limb) are not
set, and use After Effects’ standard Copy and
remembered during the Replace
Paste commands to copy a custom limb to
operation. It replaces the limb layer with a
another comp.
new, basic one each time you use it.

Forward Kinematics
Forward Kinematics, or FK, allow you to animate by specifying rotation values for the
upper and lower part of the limb, instead of positioning the end controller and letting
the computer figure them out (that’s what IK is!). FK is useful in a number of different
circumstances, for example:
•
•
•
•

Swinging or dangling legs where you want the knee to stay still but move the ankle
Animating between a clockwise and anti-clockwise pose with very smooth arcs
Leg movements that flow outwards from the hip such as kicking or swimming
‘Breaking the joint’ to let elbows bend backwards slightly

Limber's FK controls are unique amongst After Effects IK solutions but fairly intuitive.
The FK property is a percentage slider that goes from 0 (full IK) to 100 (full FK). You
should animate on full IK or full FK, and keyframe the FK property between it's
minimum and maximum values when you need to change. This is sometimes called IKFK blending. When animating on IK, you keyframe the Position property of
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the end controller (or perhaps a layer that it is parented to). When animating on FK, you
keyframe the Upper FK Rotation and Lower FK Rotation values.

FK Controllers
If you have a hand or foot layer parented to the end controller, that layer won't follow
the end of the limb when you dial up FK. The solution is to click Add FK to generate a
new FK controller, and parent your hand or foot to this layer instead. If you make sure
the FK is set to zero before you click Add FK, Limber automatically does the reparenting for you.

Joint Controllers
Joint controllers follow the position of the limb joint, should you need something to
parent knee or elbow artwork to. The Joint controller has it's own Limber Joint effect on
it which allows it to auto-rotate or not, like the other controllers.
FK controllers and Joint controllers are never keyframed or positioned by the user. They
are only there for when you need a layer to parent things to. If you want to remove an
FK or Joint controller, you can’t just delete the layer, you'll need to Alt-click on the
appropriate button and the script will remove it without breaking expressions. If your
FK was set to zero, it’ll re-parent any hand or feet layers back to the End controller.

Hiding and showing Controllers
You can hide controllers by clicking Hide/Show. If you have one or more Limber layers
selected, this will hide all the controllers from those limb sets. If you have no Limber
layers selected, it will hide all the Limber controllers in your comp. Alt-clicking the
Hide/Show button will show controllers again in the same manner.
Hiding and showing controllers turns their opacity to 0 or 100 rather than affecting the
visibility switch for the layers. This way, you can still see and edit the motion path when
you select a controller, even if it's hidden. You can use the visibility switches for a
second level of control over hiding if you want, for example, to manually switch off the
visibility of just your start controllers, since they are often not keyframed at all.
If you Shift-click the Hide/Show button, the script will turn off the dynamic color
changes for all the controllers in the set. Shift-clicking again will turn them back on.

Changing Controller size
You can make controllers larger or smaller by clicking (or alt-clicking) the +/- Size
button. This will re-size all the controllers from the limb set. The size of child layers are
unaffected since it works on internal shape groups instead of layer scale.
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Tips and techniques
Controller Rotation
The auto-rotation of start and end controllers takes effect through an expression on
their rotation properties, but this expression allows for the user to further modify the
value, rather than totally overriding any keyframes. You can animate the rotation of your
foot like this, but since the values are always modified by the expression, it might be a
confusing way to work. A better approach is to animate the Rotation value of the foot
layer instead, and just set the end controller's rotation once, to put the pose of the foot
where you want it to be at a 'zero' or neutral rotation. This way you can easily get the
foot back to this flat position by setting it’s rotation to zero, and your values will make
more sense of how the foot is rotated
relative to the leg. Another easily missed
Limber follows AE's standard rotation paradigm
pitfall with controller rotation values is that
where 0º is north, so limbs pointing downwards
they can be affected by the process of
have 180º rotation values, not 0º as in some
parenting and un-parenting. If you parent
other tools. This means that hand and feet
layers you design may be seen to have their
a controller to a layer, rotate the parent
rotation values jump when they are parented to
layer, then un-parent the controller, the
a Limber controller. To a Limber limb they are
controller's underlying rotation property
effectively upside-down when they are visually
value will have changed, and may need to
the ‘right’ way up. This is necessary for the FK
be corrected (to zero) in order to behave
functionality, and just means your hands and
as expected again.
feet layers will often show 180º or -180º
A final reason to not keyframe the
controller rotation is that you cannot apply your own expressions to those keyframes,
e.g. to loop them.

Troubleshooting blending
If your FK blending seems to go the wrong way, it's worth checking the Rotation values
of your IK Controllers: they may be 360º higher or lower than you expect.
If you are blending FK whilst the Upper limb goes around North (e.g. crosses over 0º or
‘straight upwards’), an undesirable jump can occur in the position of the FK Controller.
Similarly, if you animate Rotate Start / Rotate End values between 0 and 100% whilst the
upper limb passes across north, their rotation will flip suddenly. This is a limitation of
our math. The only real solution is to complete the blend before (or start it after) the
point where the upper limb goes around the north axis.
Generally, try not to blend other properties whilst blending FK. If you blend between
Clockwise and Anti-clockwise whilst FK is neither 0 nor 100, it can produce odd jumps
or flips during the animation.
Limbs on full FK are always the length given in the Length properties. They are not
affected by Stretch, Anti-pop or Clockwise properties. But those properties
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can affect the apparent length of the limb when on IK. So when blending between a
pose where the limb is being significantly shortened by Anti-pop or Clockwise (or
lengthened by Stretch), and an FK pose, it can look like the limb is changing length. To
prevent this, either reduce the effects of the length-altering property before the blend
takes place, or blend at a different point in time.

Scaling
Limber limbs are formed on a shape layer
which has expressions to stop that layer
from being transformed, because it would
alter the 'world space' of the layer and
throw everything off, so you cannot alter
the Scale of a limb layer to make it bigger.
But if you want to scale a character as a
whole, you can do so using the Size Scale
property and a ‘master controller’ for you
character.

Whilst you should parent the start controllers,
and perhaps end controllers, to other layers
that are a part of your rig, you should never
parent the limb layers. If you do, you’ll find that
they don't behave like parented layers anyway,
because they have expressions on them to
reverse the effects of parenting. If you are
careful to not parent or transform the layer, you
can even delete these expressions.

A master controller would be a layer that every layer in your rig is ultimately parented to
in one way or another. This layer’s Scale transform property should match the Limber
effect’s Size Scale property when your character is at it's 'normal' size (the simplest
thing is to have them both at 100%). Make a new expression on the Size Scale property,
and pickwhip it's value to the X or the Y Scale value of your master controller. Make
sure 'Link Length to Size Scale' is checked on. You can then alter the scale of the master
controller, and the Limber limbs will scale up with the rest of your character.

Orphan Limb Layers
When you duplicate a Limb layer using AE’s standard Edit>Duplicate command, the
new copy is effectively orphaned from the limb layer set. It’s expressions still refer to the
same controllers, but the Limber script code itself will no longer know about this
orphaned layer. When you use Limber’s Copy button, Limber judges which limb layer
you want to copy. If you have a limb layer selected, that is the layer that will copy, even
if it’s an orphaned layer. But, if you have any other layer selected, e.g. a controller, it
will copy the style of the original, non-orphaned limb layer. In addition, you cannot
Replace or Duplicate these orphaned layers. Trying to do so will result in the nonorphaned layer being swapped or duplicated instead.
Similarly, when you paste a limb, it will only paste to an orphaned limb layer if you have
that layer selected. If you have a controller selected, it will paste to the non-orphaned
limb layer.

How to use the Limb Library
The custom limbs in the limb library are organized in separate comps and have notes
and tips that explain what they do. In After Effects, go to File > Import > File
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and import the Limb Library AEP into your project as a folder. You can then browse the
custom limbs, and copy and paste them into your characters for use. Remember you can
Alt-paste to preserve Length, Size, Color and other options in the Limber effect. If you
come up with a new custom limb or style you particularly like, you can save it in a new
comp in the limb library for future use. If you want to design your own custom limbs,
you may want to start with one of these existing comps instead of a basic limb.

Customizing Limbs
Limb customization is a powerful tool to an experienced AE user. This section covers
how Limber's expressions and shapes work under the hood, to act as a reference for
anyone making more advanced custom limbs. This is a more in-depth section that
requires knowledge of expressions, property-linking, and how shape layer objects ‘nest’
inside one another.

The Admin Group expressions

Inside a limb’s end controller is the Admin shape group. The Admin group is where
values are ‘stored’ in expressions that are referenced in turn by expressions in the other
limb layers. This saves processing the same long calculation many times. You shouldn't
modify any of these Admin expressions, but you may need to grasp what they
represent, if you want to link expressions of your own to them.
Each limb's geometric ‘skeleton’ is based
on two sides of a triangle. These naming
conventions are used:
p1 - The position of the start controller
p2 - The position of the joint or knee
p3 - The position of the end controller
s1 - The length of Side 1, between p2 and
p3, the lower limb
s3 - The length of Side 3, between p1 and
p2, the upper limb
A1 - The angle of the upper limb (s3)
(relative to 0 degrees / north)
A2 - The angle of the lower limb (s1)
(relative to 0 degrees / north)
C1 - The circle at the start point (p1)
C2 - The circle at the middle point (p2)
C3 - The circle at the end point (p3)
So p1 in the Admin Group, for example,
takes it's Position value from the position
of the start controller. Then, inside the
Limb layer, the entire Upper Group then
takes it's position from the p1 expression
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(and it's Rotation from A1). Any shapes nested inside the Upper Group will be
positioned and rotated along with it.
The basic tapered Limb layer is comprised
of four main sub-groups: a Proximal Upper
and Distal Upper contained in the Upper
Group, and a Proximal Lower and Distal
Lower contained in the Lower Group. The
upper refers to the bicep or thigh half of
the limb (s3), whilst the lower refers to the
forearm or calf (s1). The names proximal
and distal refer to proximity or distance to
and from the body, so the distal groups
are the lower ones of the pair.
Inside any of these four sub-groups, the
same kind of structure can be found: A
Wedge Group, two Circle Groups called
something like C1 Group, a Merge Paths, a
Crop Group, a second Merge Paths, and
lastly a Fill. Within each Upper or Lower
Group, the Proximal and Distal sub-groups
are identical except for how they are
cropped by the Color Split controls (the
Crop Group), and what Fill they have.
The Wedge Groups are a little different
between the 2017 and the 2018 basic
limbs. Before CC2018, there was no way of
drawing a path with expressions, so to
make the wedge shape we have to use
three rectangles that are all positioned,
rotated and intersected. In CC2018 and
above, we just use an expression to draw
the wedge shape. Wedge Groups
reference the sizes of the circles in their
respective sub-groups, rather than
directly referencing the sizes specified in
Typical wide sleeve limb - C3 Circle has had it’s
the Admin Group. So that you can
expression deleted and been manually made larger.
disable the expression on one of the
circle’s Size properties, and it's Wedge
Group will react to that change. In this way we can make wide sleeves and cuffs, etc.
You cannot delete the circles or their groups without breaking expressions in the
Wedge and Crop Groups. But you can delete the Wedge or Crop Groups if you want to.
You can also delete a sub-group or the entire Upper or Lower Group. The Lower Group
is not dependent on the Upper Group for it's Position or Rotation.
Page 10

